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This training manual provides information and hands-on examples for how to use the Fermilab instance
of SharePoint for those with Contributor level permissions.
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Useful Online Resources

Fermilab Resources:

e Fermilab integration environment: https://intranet-int.fnal.gov/

e Fermilab integration environment “sandbox” for a new site: https://intranet-int.fnal.gov/
sandbox/ i.e. COM

e Fermilab SharePoint Help Site: https://sharepoint.fnal.gov/help/Pages/HelpHome.aspx

e Fermilab SharePoint Help Blog: https://sharepoint.fnal.gov/help/HelpBlog/default.aspx

e Latest version of this End-user manual:
https://sharepoint.fnal.gov/cd/sites/com/SharePointCOM/Training%20content/Fermilab%20Sh
arePoint%202010%20End-user%20Training%20Manual.docx

Online resources from Microsoft:

e Microsoft SharePoint 2010 | For End Users: http://sharepoint.microsoft.com/en-
us/product/benefits/End-User/Pages/default.aspx

e Microsoft “That’s why | use SharePoint” site:
http://sharepoint.microsoft.com/iusesharepoint/landing.aspx

e Microsoft SharePoint 2010 Quick Reference Cards:
http://download.microsoft.com/download/d/4/2/d4290c8a-5563-44a7-96a6-
9fe77eff40b0/qrc_all.pdf
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References

Microsoft SharePoint 2010 Plain & Simple, by Jonathan Lightfoot and Chris Beckett.
SharePoint 2010 How-To, by Ishai Sagi.

Microsoft SharePoint 2010 for Dummies, by Vanessa L. Williams.

The SharePoint Shepherd’s Guide for End Users, by Robert L. Bogue.

Beginning SharePoint 2010: Building Business Solutions with SharePoint, by Amanda Perran,
Shane Perran, Jennifer Mason, and Laura Rogers.
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This training manual is also built upon the “SharePoint 2010 End User Information” quick guide
developed by Alicia Simmons.

Additional training opportunities

SharePoint computer-based training for Employees
Fermilab employees can request online, Computer-based SharePoint training through the Fermilab

Service Desk:

1. Login to the Service Desk. From the “Self-Service” area, select “Service Catalog”.

2= Fermilab

Bl Welcome: Kimberly Myles

Type filter text AAZEH~
Self-Service =
{2} Homepage .
£ Employee Self Service

(3 service Catalog & —
& Knowledge

2. From the “Desktops and Laptops” area, select “Microsoft E-Learning”

« Service Catalog

= Desktops and Laptops = Email & Calendaring

& Order Accelerator Division Approved Laptops and Desktops %, Request Email Account

K Order a New Laptop/Desktop and Peripherals «, Request Inbox Size Increase

& Request a Loaner Laptop @ Request Instant Messaging Client
Request Software . Request Help with Outlook
Proprietary Product Request # Request Help with MacMail

‘03 Microsoft Home Use Program Request '{@, Request a New Listserv Mailing List

B 3 Microsoft E-Learning 4 [E] MX Record Variance Request

= Something Broken
Q Lederman Science Center Exhibit

= Accounts

@2 Comnutina llsername & Primarv Accotints
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3. A page appears providing more detail on how to register and a link to what courses are
available.

Learning Tree
Learning Tree offers a series of SharePoint classes suitable for all levels of users.

List of SharePoint classes offered by learning tree:

http://www.learningtree.com/training-directory/sharepoint-training-6.htm

Please consult your manager or supervisor to determine if you can attend one of these classes.
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Introduction

SharePoint is an extensible and scalable web-based platform that
supports the collaboration and sharing of information within teams
and throughout the organization. It has a Microsoft Office-like
interface and is user-configurable and adjustable.

You can use it for cross-platform file sharing, web content
management and document management.

One common use of SharePoint is to create sites that are used for
team collaboration. These collaborative sites, also known as team
sites, enable team members to better work with one another.
Teams can use their site to share documents, assign tasks, track
team events on a shared web calendar and much more.

1) Authentication
1.1 Login to SharePoint

Depending on the platform you are using (Mac, PC or Linux) you
can use the following web browsers to access SharePoint:

e Internet Explorer
e Mozilla Firefox

e Google Chrome
e Safari

SharePoint tips

SilverLight is an application that
optimally enables multimedia,
graphics and animation to run on
SharePoint.

You can check to make sure the
SilverLight player is installed on
your system from the following
Microsoft site:

http://www.microsoft.com/getsilverligh

t/Get-Started/Install/Default.aspx

For PC users: Silverlight is normally
installed by default.

For Mac users: you may need to
download and install the player
from the Microsoft site above.

Authentication tips

To avoid compatibility issues, start
SharePoint in a 32- bit browser.
For more detailed information
regarding supported browsers,
please visit:
http://technet.microsoft.com/en-
us/library/cc263526.aspx

Fermilab SharePoint Training
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To Login:

The URL is: https://sharepoint.fnal.qov/

1) From the upper right hand corner of the page, click “Sign In”.

o) »
R§ Sharepoint

o Search sl s @

Fermilab SharePoint collaborative site

About Fermilab.

2) Enter your Services Account username and password and click “Sign
In”.

£ sign In

Please enter your Services usemame and password.

User narme: [

ssword: |

Sign In

Login tips

. If you do not have a Services

Account but you have a valid,
active Fermilab ID number, you
can request a Services account in
Service Now:
http://computing.fnal.gov/xms/Se
rvices/Getting_Started/Introductio
n to Computing at Fermilab/Get
ting Started as a Non-
Employee Off-site User

° If you do not have a valid ID

number, please fill out the
following form to request one:
https://computing.fnal.gov/offsite

visitor/offsite_acct_request.shtm
|
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2) Working with a Fermilab team site

One of the fundamental kinds of web sites that SharePoint 2010 allows you to create is a team site. A
team site is a SharePoint site that you can use to collaborate with your coworkers. Other types of
SharePoint 2010 web sites are covered in Section 7.

Note: Each organization at Fermilab will be given a SharePoint site collection sandbox (test site). Your
SharePoint trainer will provide the URL during your training session.

2.1 Team site features

All SharePoint team sites have the same features:

a. Header; The header spans the entire top of the page.

b.~ Left navigation menu or “Quick Launch bar”: the navigation pane provides quick access
to the site’s document libraries, Lists and discussion boards- any features configured on
this site. You can even add links to content you create, such as documents and web
pages.

c. Page content: The content displays in the body of the page.

| Pl Browse Page
.

| &) ENERGY

S » Home

Site Pages

Shared Documents Welcome to your site!

Calendar Add a new image, change this welcome text or add new lists to this page by clicking the edit button above. You can
click on Shared Documents to add files or on the calendar to create new team events. Use the links in the getting

Tasks started section to share your site and customize its look.

Team Discussion Shared Documents

E Type Name Modified Modified By

There are no items to show in this view of the “Shared Documents” document library.

[ Al site Content

Getting Started
& share this site

I change site theme

[&) setaseicon

[ customize the Quick Launch

Fermi National Accelerator Laboratory | Office of Science / U.S. Department of Energy | Managed by Fermi Research Alliance, LLC | Security, Privacy, Legal

Done € Local intranet | Protected Mode: Off 3 v R100% ~
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All new SharePoint team sites have the following features:

a. Site Actions menu: This menu is used by Site Owners and Administrators to control site settings.
Page up icon: Allows you to view the current page and any pages above it in navigation.
Ribbon tabs: These include tabs for Browse or Page. Browse enables you to view a team site, Page changes the view
to a ribbon view. From the ribbon, you can manage page permissions, settings and library permissions and settings.

d. Search Scope: This dropdown menu features search refiners that help to narrow your search criteria.

e. Search box: This is the field search content is entered into.

f.  User menu: If you click on your Name, a dropdown menu appears with links to your My Site, My Profile, My Settings
and options to Sign in as a different user, Request Access to the site (if you are a visitor) and Logout.

g. Navigation bar: This bar is used to navigate to different sites. ltems can be added, moved or renamed by Site Owners
or Administrators.

h. Tag buttons: Click to tag pages or documents that you want to easily track and “like”, Likes and Tags will appear on
your MySite.

i.  Help button: Provides links to Microsoft Help topics.

j-  Breadcrumb trail: This navigation displays a set of links at the top of Web pages to show where you are in the site
hierarchy.

k.  Site introduction: This is your team site greeting which provides information to visitors about your site.

I.  Shared Document Web Part: This is a document library that allows Site Owners and contributors to upload and
download content into the library.

m. Site Image: This is an out of the box image that appears for sites by default. Site contributors can change this image or
remove it altogether.

(See image on page 9 for more information)
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2.2 Create a My Site Team Site for production testing purposes

Anyone with a Services Account and password can create a My Site team site sub-site for use as a
production sandbox to test basic SharePoint features covered in training.

NOTE: For more complex testing, please test in the integration environment: https://intranet-

int.fnal.gov/Pages/Default.aspx

To create a My Site team sub-site in integration:
1. In the upper right hand corner of any page click the link for your name.

2. Select "My site" from the dropdown menu.

P Kimberly Myles ~
i My Site

Open your personal homepage{7

My Profile
I View and manage your profile.

My Settings
3//“ Update your user information,
y: regional settings, and alerts.

Sign in as Different User
Login with a different account.

o Request Access

I Email the site administrator to
request additional permissions.
Sign Out

A Logout of this site.

3. From the My Site page that appears' top menu, select "My Content"

4. From the team site page that appears (with your name as title), select "Site Actions" and then "New
Site".5. In the create menu that appears, select the Team Site template. 6. Add a title such as "Kim's
sandbox" and name the URL (which can be the same as the title).

7. Click "Create" to create your new sandbox team site collection.
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Create

Browse From:

Installed Items

Title Type 4

Office.com

Filter By:

All Types > %
Site

Team Site
All Categories »

Application Templ...

Blank & Custom

-
Collaboration 85’%

Content

Data Blank Meeting
Workspace

Mestings

Search

Tracking

Web Databases I

Blog

&

Contacts Web
Database

W

Blank Site

el

Decision Meeting
Workspace

Group Work Site

B

Issues Web
Database

5

Document
Workspace

Social Meeting
Workspace

Assets Web
Database

e
Projects Web
Database

Basic Mesting
Workspace

7

Multipage Meeting

Workspace

Charitable

Contnbutions Web

Document Center

Search Instafled Items

Team Site

Type: Site
Categones: Collaboration

A site for teams to quickly organize,
author, and share information, It
provides a document library, and lists
for managing announcements, calendar
items, tasks, and discussions.

Kim's sandbox

https://sharepoint.f.../<URL name>
[K:m’s sandbo

| Create | | More Options |

Fermilab SharePoint Training
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2.3 Modifying a team site home page

1) Browse to the home page of your team site and Team site tip
then click “Site Actions -> Edit Page”.

Please do not cut and paste content into a wiki
page from any sources outside of SharePoint. This
can cause formatting issues and freeze the page.

dit Page . .
vsdit the contents of this page. Instead, cut and paste content into a text editor
such as Notepad for Windows or TextEdit for Mac
—\] Sync to SharePoint Workspace . . .
S Creat= 2 synchronized copy of first and then paste content into SharePoint.
- this site on your computer.
= MNew Page
Create a page you can
customize.
—  New Document Library
"’D Create a place to store and
share documents.
New Site
Create a site for a team or
0 project.

More Options...
Create other types of pages,
lists, libraries, and sites.

View All Site Content
View all libraries and lists in this
site.

3 , Edit in SharePoint Designer
'F» 3 Create or edit lists, pages, and
A workflows, or adjust settings.

Site Permissions
@ Give people access to this site.

2 Site Settings
Access all settings for this site.

The page appears in Edit mode.

ctions ~ |73

@ Gy 0

A’ py 0o <><1> a ’

Copy Lg select »
Save & Close Check Out  Paste Styles  Speling ~ Text  Markup
= < - Undo . - - Layout= Styles= <ZHTML
Edit Clipboard Font Paragraph Styles  Spelling _Layout Markup
Libraries
Site Pages

Welcome to your site!

Shared Documents

Add a new image, change this welcome text or add new lists to this

Lists page by clicking the edit button above. You can click on Shared
Documents to add files or on the calendar to create new team events.
Calendar Use the links in the getting started section to share your site and
customize its look.
Tasks
Discussions Shared Documents
Team Discussion :
O Type Name Modified Modified By
= There are no items to show in this view of the "Shared Documents" document
&l Recycle Bin library. To add a new item, click "New" or "Upload".
(2D All Site Content 4 Add document

Getting Started

&B share this site

B& change site theme

[53] set a site icon

B customize the Quick Launch

2) With the page in Edit mode, you can place your cursor anywhere inside the rectangular boxes
in the page’s body to edit the content.
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2.3.1 Changing a page title or text
1. While in edit mode, click on the page and your input will appear wherever your cursor is.

|
” L Cut - <> @ -
H ﬁ Verdana - 2em - T & w [

Copy

g Select =
jave & Close CheckOut  Paste B Z U she x, 3¢ A.IA EEE Styles  Speling  Text  Markup
. . 2 ¥) Undo . = 2 - D El - .- s 5 Layout= Styles = <} HTML =
Edit Clipboard Font Paragraph Styles  Spelling  Layout Markup
Libraries
site Pages Test Sltel 3 v

Shared Documents

Add a new image, change this welcome text or add new lists to this
Lists page by clicking the edit button above. You can click on Shared
Documents to add files or on the calendar to create new team events

Calendar Use the links in the getting started section to share your site and
Tasks customize its look.
Discussions

Shared Documents
Team Discussion
E Type Name Modified Modified By
— There are no items to show in this view of the "Shared Documents" document
4 Recycle Bin library. To add a new item, click "New" or "Upload".

() All site Content:

& Add document

Getting Started
& share this site
B change site theme
[&] set a site icon

[® customize the Quick Launch

2.3.2 Changing the page layout
1. Click “Text Layout” on the Ribbon and make a selection from the menu options.

Site Actions ¥

. ! [ Alicia B Simmon|
| T E Cl  Format Text | Insert

5 Cut ==
ll_j ﬁ Verdana - gt - = £ iE v A/ ’v

- <> ﬂ..h -
Copy = g <P s select
Save&:(lose Chacf out Paste s B 7 Uasex, X ¥.A. 45 @g == Sty'\es Spelllng r;nt)a’g:e S
Edit Clipboard Font Paragraph Styles  Spelling =1 One column
Libraries —I
Site Pages Test Site ‘ ‘ d One column with sidebar

Shared Documents

Add a new image, change this welcome text or add new lists to this
Lists page by clicking the edit button above. You can click on Shared
Documents to add files or on the calendar to create new team events
Use the links in the getting started section to share your site and
sk customize its look.

17} Two columns
ud

Calendar | Two columns with header

Two columns with header and footer

Discussions Shared Documents

Team Discussion Three columns

[ Type Name Modified Modified By
) There are no items to show in this v
Recycle Bin library. To add a new item, click "New

(2 A site content

of the "Shared Documents" document
or "Upload"”.

Three columns with header

% Add document Three columns with header and footer

I

| Getting Started
& share this site
IS change site theme
(5 set a site icon

[ customize the Quick Launch
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2.3.3 Adding a page image
To remove a page image:

1. Click on the image you want to change and delete it.

SharePoint COM project * Home

SharePoint COM project site

To add a page image:

1. In edit mode, place your cursor in the area of the page
where you want the image to appear. Image tip

2. Click on the Insert tab and select the “Picture” icon. You can add organization charts,
diagrams and other images you create in
PowerPoint to a SharePoint team site by
saving them locally as .jpegs and then
importing them as a “picture”.

N « ¢ CETETTE
PowerPaints SharePoint COM project site SharePoint COM project $Fermilab | @ EneRGY

Site Pages. iy
The focus of the SharePoint COM project includes:
ARCHIVE
* Help site development

+ Development of help Toots" such as FAQS, user guides, quick ouides
+ Assistance with ste agministrator and end user training
+ SharePoint Branding Group representation and input

WES S

Project Charters

Mesting Minstes + QT
+ Help Content)
BestPrachices * Bwndnd
+ My Ste]

XMS Migration

Ousncant 1n Didsinn

3. Inthe “Select Picture” dialog box that appears, browse to
find the picture you want to add and click “OK”.

€ Choose File to Uplosd ==l
(@@ . » Libraries » Pictures » Public Pictures » Sample Pictures » [ 4 | Seorch Sompie Picture 2|

Organize v New folder =--.0 @

¢ Favorites Pictures Wbrary "y o~
1 Downloads Sample Pictures
L Recent Places ;
I Desktop —
=|
gy 1 Select a file to preview

% Documents Chrysanthemum. Desetipg

o Music

3
= Pictures
B videos ey

M Comoiter

File name: | v [AnFiles () -

cnea

4. In the Site Assets dialog box that appears, you can add a title for your image.
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5. Click “Save”.

Site Assets - Penguins.jpg

Edit
WE ni X
s B 3 copy
Save Cancel Paste Delete
Item
Commit Clipboard Actions

o The document was uploaded successfully. Use this form to update the properties of the document.

Name * Penguins ipg
Title
Created at 5/29/2012 8:35 AM by Kimberly Myles R ) ( ==

Last modified at 5/29/2012 9:58 AM by Kimberly Myles

6. Your image will appear on the page. You can re-size it by clicking on it.
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2.3.4 Uploading documents

SharePoint 2010 uses a special kind of container —a Document Library — for storing files. Your team site
has a common default Document Library called “Shared Documents” where you can put documents you
want to share with others. Find out more about Document Libraries in Section 4.

1) Click “Shared Documents” in the left navigation menu.

Documents
Shared Documents
Site Pages

Drop Off Library
Lists
Calendar

Tasks

Discussions

Team Discussion

Sites

People and Groups

g All Site Content

2) Click “Upload Document” on the “Document” tab.

Library Tools
Site Actions v ﬁ Browse Documents
Dy ‘} 1 Check Ou
.| L —
New Upload New Edit

Document+ Document~ Folder Document

New Open & Check Cut

3) Click “Browse” and select a file to upload.

4) Click “Ok”.

5) Fill out the “Name” and “Title” field respectively.
6) Click “Save”.

2.3.5 Adding calendar items
SharePoint 2010’s team sites provide you with a default calendar for tracking your team events. This

calendar can be connected to and viewed in Outlook.

1) Click “Calendar” in the left navigation pane.
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Documents
Shared Documents
Site Pages

Drop Off Library
Lists
Calendar

Tasks

Discussions

Team Discussion

Sites

People and Groups

() All site Content

2) Click the “Events” tab and then click “New Event”.

Calendar Tools

Site Actions v Browse Events Calendar

Version History

3 Event Permissions

m
<
m
2
E
4
I
m
a2
E
m

3) Type the information for your event.

4) Click “Save”.
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3) Site Navigation

3.1 Page Up button

You can navigate to upper-level sites by clicking the “Navigate

Up” button kil from the navigation bar.

Browse

This page location is:
# Trair Office of The CIO
Ls Communications
il L Training
Libraries Ly Home
Site Pages INralrAamao A e

This feature shows you where you are at within a site. You can
click on a site or sub site name to navigation to that site.

3.2 Search box

Search tips

. The only search items that will appear after
you’ve conducted a search are the items
you have permission to view.

. On your site, the search scope will default
to your site collection and search only your
site content. You can search across sites by
choosing “All sites” from the dropdown
menu.

. It takes a half hour for search to pick up
new results, such as a newly added
document or list.

From the top of any page in SharePoint, you can access a search box. In front of the search box, there is
a search scope drop-down list. You can use this list to narrow or “refine” your search by, say, a person or

site.

ILike It

Search cd-sites-com :] pel

This Site: Communicationg

nts

ve announcements, To

If you receive far more search results than you were expecting, you can use search scope refiners to drill

down into the results to find exactly what you are looking for.

1) Select the search scope you want to use from the drop down list.

2) Type your search term and click the magnifying glass icon.

Ilikelt

All Sites _'_] safety e

3) Click the refiner you want to use, e.g. Webpage.
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All Sites | People

Preferences
l safety P (Rduancad

Result Type
Any Result Type

——) \V=bpage
Adobe PDF
Word

PowerPoint

Site
Any Site

sharepoint.fnal.gov

Author

Any Author

James H Niehoff
John E Anderson Jr
Thomas Page
Heather Kumlin X8...

show more v

Medified Date

A MAAAIEIAA Aabn
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4) Working with Document Libraries

A Document Library is a special kind of List (find out more about Lists in Section 6). Document Libraries

allow you to manage files such as documents, spreadsheets, and presentations.

A SharePoint site can contain many Document Libraries, and each Document Library can contain a

hierarchy of folders and files.

4.1 Upload a file to a Document Library
1) Select the “Documents” tab under “Library Tools” on the Ribbon.

2) Click “Upload Document”.

Library Tools

New Upload New Ednt
document v |Document v Folder Document | @l Discard Check Out
AN TN Upload Document
X | Upload a document from your computer to
Pictures ‘»j this fibrary.

nicatic

Cookie Ca 4% Upload Multiple Documents
Upload muttiple

- cuments from your

Talk Pictur T J
computer to this Y

ek, 3 JTSTT LA AR anRYT

3) Click “Browse” and in the “Choose File” dialog box, select a file to upload.
4) Click “OK”".
4.2 Upload multiple files to a Document Library

NOTE: This procedure is for PC users only.

To copy multiple documents (or folders) and move them to another document library:

1. From the Library Tools menu, select “Library”.

Libr ool

Browse Documents Library

# Training » Management Documents *» All Documents

Training

Libraries [ Type Name

Site Pages &) ARG
Management )
Documents @ Test document 2
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Select “Open with Explorer”.

Library Tools

Kimberly Myles +
Site Actions ~ @  Browse Library
: 2 Show Task Pane _. ([ Modify View . Current View: —~ N @ 53 & 0] Connect to Outlook ) = @ @
- _ | O @ E g ‘ Z2RE o & &

@) 2] Show Totals D' o create Column | AllDocuments (=) & gz 3l (] Export to Excel -2 b
Standard| Datasheet  New Create Emaila Alet RSS  Syncto SharePoint Connectto —_ FormWeb Edit New Quick Library Library  Workflow
[ View"| “View " Row () Refresh Data View [ NavigateUp ¢ CurrentPage link® Me~ Feed Workspace Office~ [ Open with Explorer  Parts»  Library  Step  Settings Permissions Settings +

View Format Datasheet Manage Views Share & Track Connect & Export Customize Library Settings

Hold down your CTRL key and select all of the documents you want to copy, then right click and
choose the “Copy” option.

GU ‘ <« https://sharepoint.fnal.gov » cd » sites » com » SharePointCOM » Training content »

8 Downloads

%l Recent Places

4 Libraries
% Documents

o Music

=] Pictures

B videos

8 Computer
&L Local Disk (C:)

€ Network

File Edit View Tools Help
Organize v [ Open
i Favorites
Bl Desktop

Burn New folder
Name Date modified Type
Archive 3/2/2012417PM  File folder
Change Management 9/19/20114:36 PM_ File folder
1] Best Practices for [ 55 Convert to Adobe PDF soft Word D..,

@) Fermilab SharePoi|
@) Fermilab SharePoi

&) Training topicsds| @

Combine supported files in Acrobat...
Scan for Viruses...

Snagit

Copy as path

Send to

Cut

Copy

Create shortcut

Delete

Rename

Properties

sof

Vord D...
D.

soft Excel W.

4. Navigate to the document library you want to copy these documents to and from the Library

Tools menu, select “Library” and “Open with Explorer”.

5. In “Explorer view”, right click and select “paste” to paste the documents into the new document

library.
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5) Working with documents

SharePoint 2010 provides two methods for working with documents:

> Each document has an “Edit” menu that you can use to take some action on that document,
such as checking it out for editing.

> The Ribbon also displays a set of actions that can be taken on individual documents or a
group of selected documents.

5.1 Using the Edit menu
You see the Edit menu when you hover your mouse over the “Name” of your document. With the “Edit”
menu, you can view and edit properties.

[ Type Name M

@J Communications and Outreach Change Risk Classification Guidance v |9/
View Properties
% Add document i
[ Edit Properties
Lﬂ_] Edit in Microsoft Word
‘_b Check Out
_}J] Version History
Compliance Details
G/J Workflows
Add to My Links
Alert Me
Send To >

Manage Permissions

X @

Delete

5.2 Editing a document’s properties
The easiest way to edit a document’s properties is to use the Ribbon:

1) Select the document in the Document Library.
2) Click “Edit Properties” on the “Documents” tab of the Ribbon.

Library Tools
[ovcrers | o |

'_j\ __b Check Out = l e i‘ Version History
= A =)
: {3 Check In - $ Document Permissions
aw Edit WO Edn
der Document |, Discard Check Out ~ Properties {Properties: >< Delete Document
Open & Check Out Manage
[7 Type Name
v @J Communications and Outreach Change Risk Classificatio

3) Make the changes and click “Save”.
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5.3 Checking documents in and out

Checking out a file prevents other users from editing the file while you are working on it. New edits you

make do not show until you check the file back in.

To check out a document:

1) Inyour Document Library, select the check box next to the document you want to check

out.
2) Click “Check Out” on the “Documents” tab of the Ribbon.

Library Tools

Ste Actions v @ Browse

ﬁ 1 gb : ] E .é Version History 7 e N QJ Send To
j j _‘ 'J'd B ’ -2 @ Document Permissions \—l "é 41@ _zj Maznzge
New Upload New Edit View Edit E-mail 2 Download 2
Document v Documenty Folder Document eck Out Properties Properties )( Delete Document Link Copy 4 GoTos
New Open & Check Out Mznage Share & Track Copie:
Pictures ¥V Type Name
SockdeiCatcls @ Communications and Outreach Change Risk Classification Guidance
Talk Pictures
Lobby display % Add document
3) Click “OK”.
To check in a document:
1) Click the check box next to the document that you want to check in.
2) Click “Check In” on the “Documents” tab of the Ribbon.
3) Inthe Check in dialog box, do any of the following:
o Select “Yes” or “No” to keep the file checked out or not.
e Enter any comments to include in the document’s revision history.
4) Click “OK".
5.4 Sending a link to a document by e-mail
To share your documents with others, they need to know where to find the document. You can do this
by sending them a link directly to the document itself.
To email a link to a document:
1) Inyour Document Library, select the check box next to the document you want to email.
2) Click “E-mail a Link” on the “Documents” tab of the Ribbon.
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Library Tools

Site Actions v

L]

.If} T W _é,Checb: Out Z=x] z .3 Version History a8 PN ﬁSerd To
| El ) H | ; i
b - Check In o @ Document Permissions ;S Manzage
New Upload New Edit ] View Edit E-mail 2 Alert Download a
Documenty Documentv Folder Document |, Discard Check Qut ~ Properties Properties >( Delete Document Link Me » Copy GoTo S
New Open & Check Out Manage Share & Track Copie
Pictures V Type Name

Cookie Caucus R T RN 3
Communications and Outreach Change Risk Classification Guidance

Talk Pictures

Lobby display 4 Add document

Your default e-mail application will open a new message with a link to the document. You
can choose who to send the link to and send the message as you would any other e-mail.

To email more than one link to more than one document:

1)
2)

Right click on the name of the first document you want to copy a link for.
In the drop down menu that appears, select “Copy shortcut”.

I
Open
Open in New Tab
Open in New Window
Save Target As...
Print Target

Copy Shortcut

3) Paste the link in an email and repeat these steps for each link you want to send.
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5.5 Recover deleted documents

When you delete a document from a Document Library, it isn’t gone
forever. The document just moves to a holding place in your site — the
Recycle Bin.

To restore a document from the Recycle Bin to its original location:

1) Click the Recycle Bin link in the left navigation pane.

Documents
Shared Documents
COM Documents
Drop Off Library

Status Reports

Lists
Ccom calendar

Discussions

COM Team Discussion

Sites
People and Groups

A Recycle Bin

=] All Site Content
2) Place a check mark next to any files you wish to restore.
3) Click the “Restore Selection” link.

5.6 Versioning

Versioning enables you to select and view previous versions of a document.

To view version history for a document:

1) Select the document you want work with.
2) On the ribbon under Library tools, select the “Documents” tab.
3) Click “Version History”.

SharePoint >..> Office of The CIO > Communications

Library Tools

Site Actions @  Browse Documents

‘ T Ly Check Out
0 0 W 2 G
k {3 CheckIn

New pload New Edit View Edit
Document . Document. Folder Document = Discard Check Qut Properties Properties )( Delete Document

& Document Permissions

New Open & Check Out Manage

4) Inthe “Version History” pop up window that appears, click a

Recycle bin tip

. Items that were deleted more
than 30 day(s) ago will be
automatically emptied.

. Contact the Service Desk if
you want to restore any item
after 30 days.

Versioning tips

o Before you can use this feature,
versioning must be enabled by
your Site Administrator for the
document library (or list) that
you want to work with.

. You can restore a previous
version of your document if you
are not happy with changes
made- if versioning is enabled.

. There are two types of versions:
draft versions or published
versions.

“modified date” link to view a version of the document modified on that date.
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Version History 8 x

No.yl Modified Modified By Size Comments
30 4/3/2012 11:34 AM Kimberly Myles 20.8 KB another

2.0 4/3/2012 11:33 AM Kimberly Myles ~ 20.8 K

2/28/2012 4:43 PM Fang Wang

5.7 Create alerts

Alerts are a great way to keep track of the changes your teammates make to documents.

To create an alert to a Document Library:

5)

Select the Document Library where you want to create an alert.
Select the “Library” tab on the Ribbon.

Click “Alert Me > Set alert on this library”.

From the “Version History”

SharePoint >..> Office of The CIO > Communications

= ’ — [P Modiy View ~ Current View: P = = a
0 B B QR 5

1l creste Column Al Documents

Standard| Datasheet  New Create E-msiz | Alet | RSS  Syncto SharePoint
View | View Row 2 View 4 na ¢ Current Page Link | Mev | Feed Workspace

Fomat S g Set slert on this fibrary
Pictures Name |57 Minage My Alerts

Cookie Caucus

Change Management
Talk Pictures
FermiDash home page requirements project
Lobby display

Fermitools Project Documents
Documents GCC Tour Guide Manual

Shared Documents News Center requirements project

COM Documents ORNL Conference posters

BopOIt by 0SG- Science and Application Usage Reporting
Status Reports
0SG.org Migration
How to documentation
Standard Service Communications Email Template

-
.
=
=
=
=
-
i
3
i

VM's

Lists

COM Calendar 4k Add document

Fill out the form and click “OK”.
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6) Working with Lists
SharePoint 2010 provides many kinds of Lists that you can use to track information. A List is similar to an
Excel spreadsheet or a table in a database.

In a List, data is gathered in rows, and each row is known as a List Item. A List can have multiple
columns. A List Item is a row with data in those columns.

For example, a List of Fermilab contacts may have the following columns:

e First Name
e last name

e Fermilab ID
e QOrganization
e Email

e Phone

SharePoint provides three basic kinds of Lists:

» Communication Lists are used to track announcements, contacts, and discussion boards.

» Tracking Lists are used to track information such as links, calendars, tasks, issues, and
surveys.

> Custom Lists provide a starting template that you can build on to create a List with the exact
columns you need.
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6.1 Use the Ribbon to manage Lists
All SharePoint Lists display the Ribbon at the top of the List. You can use the Ribbon to access the
common tasks used for working with Lists.

The menu commands you see in the Ribbon depend on the kind of List you are viewing. Usually the
Ribbon displays List commands in one of two tabs:

> Items: displays all the commands you need for working with items.

Ste Actions v @  Browse

> List: displays commands for managing and customizing the entire List, such as creating views
and exporting the List to Excel.

Ste Actions v Browse Items.

— Show e — [ Modity View  Curent View — N | 375 54 Form web pars + A
R ‘ d B S5 I S
)‘ J o ) 1l Create Column | Al Ttems - ‘—] - “w o Egit List @ <
Standard| Datasheet  New Create Emasiz  Aet  RSS  Syncto SharePoint C = List Lt Workfow
View e Ro: View [ Current Page Link  Mey  Feed Workspace ] New Quick step Settings Permissions Settings v
Share & Track e List Settings

6.2 Create a column
1) Select the List you want to work with.

2) Click the “List” tab on the Ribbon.

List Tools

SteActions v @  Browse Ttems List

L_} Form Web Parts v = ﬂ @ @
3 &,
@A o dit List &

List Lt Workflow
7] New Quick Step  Settings Permissions Settings v

j [ Modity View + Curent View ) \;J A @ &1&

Tl creste Column | A Ttems
Crexte Emsiz  Aen  RSS  Syncto SharePoint Con
View [ Curent Page Lk Mev Feed forkspace

t & Export Customize List Settings

Share & Track

List Tools

8| — S = [[p Modify View - Current View 3 ) @ S ]
_)‘ LJ o ) {] Creste Column Al tems - ‘—] A = -

Standard| Datasheet  New Create E-mailz  Alent RSS  Sync to SharePoint Con
View View Row ) 2 Vig A rkspac o

@ |54 Form web Pans {(}; \‘% @

o Edit List
Customize List List  Workfiow
Form 72| New Quick Step  Settings Permissions Settings v

Current Page Link  Mey  Feed Worksp:

Share & Track Customize List Settings

4) Enter a name for the column.
5) Select the type of information you want to store in the column.

6) Click “OK”.

Fermilab SharePoint Training Page 29



6.3 Create a List View
Views provide a flexible way to create custom display forms for users interacting with list data. Views

provide the ability for you to control which fields are displayed; the order in which fields appear in the
list; and advanced multicolumn sorts and multicolumn filtering.

To create a List view:
1) Select the List in which you are interested.

2) Click “Create View” on the “List” tab.

— Mo

\ J sd (552 Form Web Pars - | @ @
[ a I‘.\\ 5 | 2 &
0 M Creste Column Al Tasks - ‘—I U =2 Edit List @
Create E-msia At RSS  Syncto SharePoint Conn . List Lt Workfiow
View [ Current Page Link  Mey Feed jorkspace  Out New Quick Step  Settings Permissions Settings
Share & Track Co Settings
oraries T @ Type Assigned To Status Priority Due Date % Complete Predecess
:e Pages , = i
ick “ dard View”
3) Click “Standard View”.
Choose a view format
e readsheet mat that convenient for bulk e n d q
ou t of display styles SEahest - Eforhd -
=y| Gantt View
monthly calends #Q View list items in a Gantt chart to se= = graphical reprasentation of how a team's tasks ralste ovar time
— Custom View in SharePoint De:
Q oy this li t Designer e t t vith bilities such conditional
Start from an existing view
@ All contacts

4) Enter a view name. The name must be unique to the list.
5) In the “Audience” section, select one of the available options:

e “Create a Personal View” creates a view that is only displayed for you.
e “Create a Public View” creates a view that other users can select and use.

6) In the “Columns” section, do any of the following:

e Click the check box under the Display column to show or hide a column in the view.

e Change the order in which columns are displayed in the view by selecting a position
value from the drop-down list under “Position from Left”.

7) Click “OK” to save the view.
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7) Working with web pages

Your team site is a collection of web pages. Wiki pages are used
for displaying your content:

Wikis derive their name from the Hawaiian word for “quick”. The
Wiki concept is designed to be quick and easy. Use Wiki pages
when you have predominantly rich content; for example, text,
tables, links, and images.

You can insert Web Parts, or use no Web Parts at all.

7.1 Creating a new Wiki page
1) Click “Site Actions -> New Page”.

m

Edit Page
Edit the contents of this page.

Sync to SharePoint Workspace
Create a synchronized copy of
this site on your computer.

New Page
Create 2 page you can
customize.

New Document Library
Create a place to store and
share documents.

50w

New Site
Create a site for a team or
project.

©

More Options...
Create other types of pages,
lists, libraries, and sites

Manage Content and Structure
Reorganize content and
structure in this site collection.

View all libraries and lists in this
site.

Edit in SharePoint Designer
Create or edit lists, pages, and
viorkflovs, or adjust settings.

,;: View All Site Content
A

Site Permissions
\‘% Give people access to this site.

s | Site Settings
{5:;? Access all settings for this site.

2) Type the name for your page and click the “Create” button.

Wiki tip

A wiki is a website whose users can add,
modify or delete its content via a web
browser using a simplified markup language
or a rich text editor. A wiki is the simplest
online database that could possibly work...

-Wikipedia
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Note: You can change the page’s layout by clicking “Text Layout” on the “Format Text” tab.

7.2

3)

4)

P

@ O B == o A Y

Styles  Speling

> @ -
<Py seecte
Marku

Stjlesv <D HTML.

Spaling 1 One column

Documents

Shared Documents 1 One column with sidebar

and forefront cq {[ ] ng

and the people ¢ &=

innovate and support
Site Pages

Drop OFf Library =1 Two columns

Lists Untitled fE5] Two columns with header
Calendar |

Tasks =51 Two columns with header and footer
Discussions 771 Three columns

Team Discussion

1 Three columns with header
Sites

People and Groups Three columns with header and footer

Finding and linking other Wiki Pages
1) Go into the Edit mode in a Wiki page by clicking the Edit button.

Site Actions v

Click

It
I

Communications » Home

Communications Search Center SuperComputing ¥ Sector Nevsletter SharePoint COM project ¥

Pictures

Cookie Caucus Mission Statement

Talk Pictures

Lobby display The Computing Communications team provides support for the communications activities of th

Documents

Shared Documents

“View All Pages”

Site Actions v

The mission includes: librarianship of the CS document repository, the internal CS newsletter "Ct
display, coordination of the Fermilab participation in the Super Computing Conference exhibit an

The group wor}
communicatior

ecution of a Communications
vithin the sector

ij‘ ! Browse

i_:r i ;} Page History [ e _;’ ﬂ Q Make Homepage {é} @
12 *E'] : @ Page Permissions —] : . =

‘7'1 Incoming Links

Edit  Check Out Edit Rename E-maila  Alert Preview Library Library . View All
. X Properties + age ( e Link Me ~ g Draft Check Settings PermonglTV Pages
Edit Manage Share & Track Page Actions Page Library

You can link to another page in the same wiki library by enclosing the name of the page in double

brackets in the rich content area. For example, type [[Team Events Page]] to create a link to the

Team Events page.
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8) Working with Web Parts

8.1 Insertaweb part
1) Click “Site Actions -> Edit Page”.

Browse

=) Edit Page
7 Edit the contents of this page.

Sync to SharePoint Workspace
Create a synchronized copy of

9
%3 | this site on your computer.
|

New Page
Create a page you can
customize.

New Document Library
Create a place to store and
share documents.

New Site
Create a site for a team or

0 project.

More Options...
Create other types of pages,
lists, libraries, and sites.

Manage Content and Structure

ﬁ% Reorganize content an
structure in this site collection.
—u, ViewAll Site Content

‘IE View all libraries and lists in this

site.

Edit in SharePoint Designer
Create or edit lists, pages, and
workflows, or adjust settings.

A
Site Permissions
@ Give people access to this site.
35

. Site Settings
s8¢ Access all settings for this site.

2) Inaweb part page, click in a zone. In a Wiki content page, click in a rich content zone.
3) Toinsert a web part, click the web part button on the Insert tab.

Browse Page Format Text
T EHS @Y 2 Bmim
| a3 | -
L e '-4‘5 G = L 2
Table Picture Video and Link Upload Web Existing New
- v Audio - File Content « Part List List
Tables Media Links Content Web Parts

L

‘ & QN =g
Bk & @1 g il

Fang Wang ~

Tables Media Links Web Pans
Categories Web Parts About the Web Part

[ Lists and Libraries 2] |8 com Announcements COM Annour

Cas sz C ges on the home page o

Add Web Part to:Rich Content =

A G
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8.2 Configure a web part
1) Click “Site Actions -> Edit Page”.

Browse

©

= @ g

Edit Page
Edit the contents of this page.

Sync to SharePoint Workspace
Create a synchronized copy of
this site on your computer.

New Page
Create a page you can
customize.

New Document Library
Create a place to store and
share documents.

New Site
Create 2 site for a team or
project.

More Options...
Create other types of pages,
lists, libraries, and sites.

Manage Content and Structure
View All Site Content

View all libraries and lists in this
site.

ﬁ% Reorganize content and
structure in this site collection.
)

Edit in SharePoint Designer
Create or edit lists, pages, and
wiorkflows, or adjust settings.

Site Permissions
Give people access to this site.

Site Settings
Access all settings for this site.

2) Select the drop down control to the right of the Web Part title and click “Edit Web Part”.

COM Links

[}

Computing Sector Home Page
CS Document Database
Supercomputing Conference
Fermitools

Computing Sector Newsletter

4k Add new link

X

]

Minimize
Delete

Edit Web Part

3) Modify the configurations as you like.
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8.3 Remove a web part from a page
1) Click “Site Actions -> Edit Page”.

Browse

Edit Page
Edit the contents of this page.

5® @B

Sync to SharePoint Workspace
Create a synchronized copy of
this site on your computer.

New Page
Create a page you can
customize.

New Document Library
Create a place to store and
share documents.

New Site
Create a site for a team or

@ croject.

More Options...
Create other types of pages,
lists, libraries, and sites.

Manage Content and Structure
ﬁ% Reorganize content and

structure in this site collection.

View All Site Content
View all libraries and lists in this
site.

Edit in SharePoint Designer
Create or edit lists, pages, and
wiorkflows, or adjust settings.

Site Permissions
Give people access to this site.

Site Settings
Access all settings for this site.

2) Select the drop down control to the right of the Web Part title and click “Delete”.

COM Links

Computing Sector Home Page
CS Document Database
Supercomputing Conference
Fermitools

Computing Sector Newsletter

4k Add new link

Minimize
X Delete
Edit Web Part
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